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Abstract - Over the past decade the number of images being captured and shared has grown enormously with the advent of the Internet as a 
medium of sharing resources like images, audio, video, documents etc., the Web users made it a way to interchange the knowledge as well. This 
behavior of the Web users over the Internet phenomenally turned the WWW into a huge repository of unstructured data inducing a need of the 
standard based representation of the data over the Internet. This need made itself more demanding because the searching or extraction of the 
knowledge from the unorganized data was becoming impossible, giving rise to the concept of Semantic Web. The use of XML for representing 
the data made the situation at the rest in the meanwhile. But, only the syntactical exploitation of the data could not help the situation because the 
process like searching of the images on the Web demanded the inclusion of the supplement of semantic structures into the list of standards. The 
Resource Description Framework (RDF) standard, a base technology of the Semantic Web, appeared as an intuitive solution of this problem as it 
employs the concept of annotation to describe the images and keeps all pieces of information pertaining to the images in the RDF documents, 
making the search process semantic rather than the traditional. In this paper, the intent is to generate annotated RDF model for semantic retrieval 
of images using RDF editor for annotation. This RDF model is validated  
through online W3C RDF validation service. SPARQL, RDF query engine, is used to query the validated RDF model to check the efficiency of 
image search. 
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I. INTRODUCTION 

The Internet revolutionized the way in which our 
society disseminates and uses information. With the growth 
of multimedia the huge amount of images are increasing 
daily on the internet. A consequence of this popularity is an 
overload of information available on almost any topic which 
in turn has created several new problems for users. How to 
find required information from the vast ocean of information 
in such a short time has become the key constraint. In 
simple search user gets many irrelevant images and to 
retrieve the accurate images from the Web according to user 
query is a challenging task. To find the proper result from 
the web we have   to enrich the annotation process as much 
as possible and move toward the semantic image search. In 
addition, it is also difficult to verify that the information or 
even the source of the information is truthful. To present 
more precise result to each user with different occupations, 
hobbies, and some other background profiles; there is a need 
to modify search method and involve some factors of user’s 
background information. The ultimate goal is to enable 
computers to do more useful work and to develop systems 
that can support trusted interactions over the network. 

A. Resource Description Framework (RDF) 
The Resource Description Framework (RDF) [28] is a 

W3C recommendation that attempts to address XML’s 
semantic limitations. It presents a simple model that can be 
used to represent any kind of data. This data model consists 

of nodes connected by labeled arcs, where the nodes 
represent Web resources and the arcs represent properties of 
these resources. 

RDF Schema is a simple type modeling language for 
describing classes of resources and properties between them 
in the basic RDF model. It provides a simple reasoning 
framework for inferring types of resources. 

The Semantic Web contains the standards and tools of 
XML, XML Schema, RDF, RDF Schema and OWL. 

The Resource Description Framework (RDF) is a W3C 
standard for describing Web resources, such as the title, 
author, modification date, content, and copyright 
information of a Web page [8]. RDF is designed to be read 
and understood by computers and it is not designed for 
being displayed to people. It is written in XML and it is a 
part of the W3C's Semantic Web Activity. 

Resource Description Framework Define metadata 
vocabularies and use them to make statements. Resource can 
be anything identifiable with a URI, Description is a 
statement about properties of resources and Framework 
means a common model for statements using diverse 
vocabularies. RDF is a model and XML syntax for 
representing information in a way that allows programs to 
understand the intended meaning. It's built on the concept of 
a statement, a triple of the form {predicate, subject, and 
object}. The analysis of a triple is that <subject> has a 
property <predicate> whose value is <object>. In RDF a 
<subject> is always a resource named by a URI with an 
optional anchor id, <predicate> is a property of the resource, 
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and the <object> is the value of the property for the resource 
[9]. Consider the following triples (figure 1):  

{dc: Publisher, http://www.w3.org, "World Wide Web 
Consortium"} 
{dc: Title, http://www.w3.org, "W3C Home Page"} 

 
Figure .1 RDF triples 

 
B. Role of Annotations in Semantic Web 

The process of associating metadata with resources 
(audio, video, structured text, unstructured text, web pages, 
images etc) is called annotation and semantic annotation is 
the process of annotating resources with semantic metadata. 
Semantic annotations can be coarsely classified as being 
formal or informal. Formal semantic annotations, unlike 
informal semantic annotations follow representation 
mechanisms, drawing on conceptual models represented 
using well-defined knowledge representation languages. 
Such machine process able formal annotations on web 
resources can result in vastly improved and automated 
search capabilities, unambiguous resource discoveries, 
information analytics etc. The annotation of Web based 
resources like text files or digital content is very different 
from the annotation of Web services [11]. 
 Semantic Annotation moves one level deeper: 
a. It enriches the unstructured or semi-structured data with 

a context that is further linked to the structured 
knowledge of a domain. 

b. It allows results that are not explicitly linked to the 
original search. So, if tagging is about promptly finding 
the most relevant result, semantic annotation adds 
diversity and richness to the process [12]. 

II. RESOURCE DESCRIPTION FRAMEWORK 
(RDF) 

The Resource Description Framework (RDF) is an 
extremely flexible technology, capable of addressing a wide 
variety of problems as it is a language designed to support 
the Semantic Web, in much the same way that HTML is the 
language that helped initiate the original Web. RDF is a 
framework for supporting resource description, or metadata 
(data about data), for the Web and it provides common 
structures that can be used for interoperable XML data 
exchange. As a result of many communities coming jointly 
and approving on basic principles of metadata representation 
and transport, RDF has drawn influence from several 
different sources. The main influence have arrived  from the 
Web standardization community itself in the form of HTML 
metadata and PICS, the library community, the structured 
document community in the form of SGML and more 
importantly XML, and also the knowledge representation 
(KR) community. There are also other areas of technology 
that contributed to the its design; these include object 

oriented programming and modeling languages, as well as 
databases. Although RDF draws from the KR community, it 
does not specify a mechanism for reasoning [19]. 

A. RDF Triples 
A simple model for “statements” 
Subject: what the statement is about 
Predicate: a property of the subject 
Object: the value of the property 
A natural way to describe the vast majority of the data 
processed by machines. 
In figure 2, the subject is http://doc, predicate is dc:creater 
and the object is 
Joe Smith. 

 
 

Figure .2 A simple RDF assertion 
 

RDF is a general method to decompose information into 
pieces. The emphasis is on general here because the same 
method can be used for any type of information. In 
RDF information is expressed as a list of statements in the 
form SUBJECT, PREDICATE, OBJECT. The subject and 
object are names for two things in the world, and the 
predicate is the name of a relation between the two. In short, 
predicates can be considered as verbs. 

B. RDF Specifications 
The broad goal of RDF is to define a mechanism for 

describing resources that makes no assumptions about a 
particular application domain, nor defines (a priori) the 
semantics of any application domain [21].The RDF updated 
specification released six new documents: RDF Concepts 
and Abstract Syntax, RDF Semantics, RDF/XML Syntax 
Specification, RDF Vocabulary Description Language 1.0: 
RDF Schema, the RDF Primer, and the RDF Test Cases. 
The RDF Concepts and Abstract Syntax and the RDF 
Semantics documents provide the fundamental framework 
behind RDF: the underlying assumptions and structures that 
makes RDF unique from other metadata models (such as the 
relational data model). These documents provide both 
validity and consistency to RDF - a way of verifying that 
data structured in a certain way will always be compatible 
with other data using the same structures. The RDF model 
exists independent of any representation of RDF, including 
RDF/XML [20].  

C. Basic RDF Model 
RDF is model and XML syntax for representing 

information in a way that allows programs to understand the 
intended meaning. It represents information about resources 
on the Web, i.e., metadata about resources. A resource in 
RDF is mapped to a Uniform Resource Identifier (URI) and 
is described in terms of its properties. The purpose is to 
make statements about resources, which can be viewed as 
labeled edge (property) between two nodes (object and 
property value).The foundation of RDF is a model for 
representing named properties and property values. Its 
properties may be thought of as attributes of resources hence 
correspond to traditional attribute-value pairs. Its properties 
represent relationships between resources and an RDF 
model can therefore resemble an entity-relationship 
diagram. In object-oriented design terminology, resources 
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correspond to objects and properties correspond to instance 
variables [22]. 

The RDF data model is a syntax-neutral way of 
representing RDF expressions. Two RDF expressions are 
equivalent if and only if their data model representations are 
the same. The basic data model consists of three object 
types: 

a. Resource 
All things being described by RDF expressions are 

called resources. A resource may be an entire Web page; 
such as the HTML document 
"http://www.w3.org/Overview.html" for example. A 
resource may be a part of a Web page; e.g. a specific HTML 
or XML element within the document source. A resource 
may also be a whole collection of pages; e.g. an entire Web 
site. 

b. Property 
A property is a specific aspect, characteristic, attribute, 

or relation used to describe a resource. Each property has a 
specific meaning, defines its permitted values, the types of 
resources it can describe, and its relationship with other 
properties. This object type does not address how the 
characteristics of properties are expressed. 

c. Statement 
A specific resource together with a named property plus 

the value of that property for that resource is an RDF 
statement. As mentioned earlier, these three individual parts 
of a statement are called, the subject, the predicate, and the 
object respectively. 

Example: 
In RDF resources are identified by a resource identifier. 

A resource identifier is a URI plus an optional anchor id. 
Consider as a simple example the sentence: Ora Lassila is 
the creator of the resource 
http://www.w3.org/Home/Lassila. 
{Creator, http://www.w3.org/Home/Lassila, Ora Lassila} 
This sentence has the following parts: 
 

Table.I RDF Frmat [19] 

 
 
Figure 3 shows the diagram of this RDF statement 

using directed labeled graphs (also called "nodes and arcs 
diagrams"). In this diagram, the nodes (drawn as ovals) 
represent resources and arcs represent named properties. 
Nodes that represent string literals are drawn as rectangles. 

 
Figure.3 Simple node and arc diagram [19] 

Thus, such a sentence would be: The individual whose 
name is Ora Lassila, email<lassila@w3.org> is the creator 
of http://www.w3.org/Home/Lassila. 

The intention of this sentence is to make the value of 
the Creator property a structured entity. In RDF such an 
entity is represented as another resource. The sentence 
above does not give a name to that resource; it is 
anonymous, so in the diagram below we represent it with an 
empty oval: 

 
Figur.4 property and structured value [19] 

 
RDF general format: 
<? xml version="1.0"?> 
<Class rdf:ID="Resource" 
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#" 
xmlns="uri"> 
<property>value</property> 
<property>value</property> 
</Class> 

D. Advantages of using RDF: 
a. The RDF format, if widely used, will help to make 

XML more interoperable: 
Tools can instantly characterize the structure, "this 
element is a type (class), and here are its properties”. 
RDF promotes the use of standardized vocabularies, 
standardized types (classes) and standardized 
properties. 

b. The RDF format gives a structured approach to design 
XML documents. The RDF format is a regular, 
recurring pattern. 

c. It enables quick identification of weaknesses and 
inconsistencies of non-RDF compliant XML designs, 
providing better understanding of the data. 

d. RDFS gives the benefits of both worlds: 
Standard XML editors and validations to create, edit, 
and validate XML file. 

Use the RDF tools to apply inferencing to the data. 
e. It positions the data for the Semantic Web. 

III. ANNOTATING IMAGES USING RDF 

Images are not structured documents like text 
information; at the same time, the current mechanism is too 
rigid to make some modification and always ineffectively 
use information provided by users except keywords. Before 
the emergence of the RDF, the keywords for the image 
search were based on the filename of the image, the link text 
pointing to the image, and text adjacent to the image. To 
enhance and optimize search results, RDF standard is used 
now to describe the image resource with attributes as its 
weight for such content descriptive phrase, which would 
help user in providing new content description to images by 
adding new self-defined tags into resource 
description.Consider images of cars with all the possible 
specifications i.e. brand, model, color, wheelbase, 
kerbweight etc. If user’s query is for car of brand ‘Honda’ or 
‘Maruti, all the images of car will be displayed, irrespective 
of the brand mentioned by the user. 
A simple RDF for figure 5 (a) 
<? xml version="1.0"?> 
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<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-
syntax-ns#" 
xmlns:car="http://www.flickr.com/search/?q=honda+city+c
ar#"> 
<rdf:Description 
rdf:about="http://www.flickr.com/photos/marcusvieira/3839
909947/"> 
<car: brand>Honda</car: brand> 
</rdf: Description> 
</rdf: RDF> 
When the user searches Honda City car with ‘red’ color 
and/or wheelbase=2300 

And/or kerbweight=1350, the search engine will not be 
able to provide the desired result as there is no annotation 
for these attributes in the above RDF; instead, the 
information returned is of all ‘Honda’ cars regardless of its 
‘color’, ‘wheelbase’ and ‘kerbweight’. 

To make the image retrieval more accurate and precise 
and to make machine more understandable RDF document 
are augmented with self defined tags. The image annotation 
process will be improved by using such tags. In RDF 
document, we can give as much as possible information 
about any image. 
Examples: 

 
        (a) Honda City ‘red’ Car    (b) Maruti Suzuki SX4 White Car 

 
Figure.5 Cars Images with different brand, model and color 

 
Resource description framework for Figure 5(a) with 

semantic annotations 
<? xml version="1.0"?> 
<rdf: RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-
syntax-ns#" 
xmlns:car="http://www.flickr.com/search/?q=honda+city+c
ar#"> 
<rdf: Description 
rdf:about="http://www.flickr.com/photos/marcusvieira/3839
909947/"> 
<car: brand>Honda</car: brand> 
<car: model>Honda City</car: model> 
<car: color>red</car: color> 
<car: wheelbase>2300</car: wheelbase> 
<car: kerbweight>1350</car: kerbweight> 
<car: weight>10</car: weight> 
</rdf: Description> 
</rdf: RDF> 
Resource description framework for Figure 5(b) with 
semantic  
<? xml version="1.0"?> 
<rdf: RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-
syntax-ns#" 
xmlns:car="http://www.flickr.com/search/?q=maruti 
Suzuki+sx4+car#"> 
<rdf: Description rdf: about=" 
http://www.flickr.com/photos/labeebxaman/ 
2528477801/"> 
<car: brand>Maruti Suzuki</car: brand> 

<car: model>SX4</car: model> 
<car: color>white</car: color> 
<car: wheelbase>2250</car: wheelbase> 
<car: Kerbweight>1100</car:kerbweight> 
<car: weight>9</car:weight> 
</rdf: Description> 
</rdf:RDF> 

When user searches Honda City ‘red’ car or car with 
wheelbase=2300 or kerbweight= 1350, the search engine 
will make inference based on the corresponding RDF 
document and finally provide the set of images (given in 
figure 5(a)) fulfilling the user demand. Similarly, when the 
user searches Maruti Suzuki SX4 white car with 
wheelbase=2250 and kerbweight=1100, the search engine 
will make inference based on the respective RDF document 
and finally provide the desired image (given in figure5 (b)). 
Hence, by creating the RDF document for any image or 
resource and providing maximum content description to that 
image or resource, we have enhanced the searching process 
and the images retrieved are more semantic in comparison to 
traditional search. 

Second enhancement proposed in this thesis for 
semantic retrieval is to add weight tag in RDF document. As 
the number of users of any image increases, the weight 
corresponding to the searched keyword will increase and 
therefore increasing the ranking of that image with respect 
to that searched keyword.  By injecting the Web 2.0 features 
we can obtain more semantic image content description in 
the following ways: 

The third idea [23] proposed for increasing the semantic 
image search is to add category tag which can further 
increase the accuracy and precision of search. While 
performing search operation, the user’s background 
information is added in the related RDF document as 
additional semantic information for keywords to overcome 
from the situation where that keyword has several various 
meaning in different contexts. 
To present more precise result to the users with different 
occupations, hobbies, and some other background profiles, 
we need to modify ranking algorithm for accommodating 
the factor of user interaction in order to present individual 
ranked result for various individuals even they use the same 
keyword to perform search operation. New evaluation 
method is: 

For each image, except content description, add 
category description: 

 
Figure .6 Image search result for eclipse keyword RDF for adding category 

tag 
<category> 
<class attribute=’ ’>weight</class> 
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… 
<class attribute=’ ’>weight</class> 
</category> 
<class> tag’s attribute corresponds to users’ background 
info description terms like occupation: ‘software engineer’, 
hobby: ‘cars’, ‘astronomy’, etc. 

Figure.6 shows the example of using user background 
information for describing the category of images. As some 
people searching for images of cars would probably choose 
the first image. As soon as, the car fans choose the first 
image as the result for the search after keyword of ‘eclipse’, 
this image would add value car to the attribute ‘attribute’ of 
<class> tag to the category description section and with 
other car fans ‘confirmations, the value of weight for 
<class> tag will be increased for that particular value of 
‘attribute’ attribute. The similar procedure will be followed 
in case of software and astronomy. 

Rank Grade = Class Weight + keyword Weight 
The Rank Grade will decide the search result of images. 

If one image has highest Rank Grade, it will come on the top 
level of the result and other images with the lowest Rank 
Grade will come in the last page. The Rank Grade totally 
depends upon appropriate semantic annotation of images 
and semantically searches of those images. 

IV. TOOLS AND BROWSERS 

The following tools have been used in solving the 
problem stated in problem 
statement section. 

A. RDF Editor 
RDF Editor is used to write and edit RDF documents. It 

generates and saves N-Triple reports on any platform. 
RDF Editor Interface: 
Available Menus 

File Menu 
File -> New - Creates a New RDF File. 
File -> Open - Opens a current existing RDF File. 
File -> Save - Saves the currently open RDF File. 
File -> Save Report - Saves the report that you have 
generated. (Report area is the text area in the bottom half. 
Whatever you see there will be saved). 
File -> Exit - Exit the application. 

Edit Menu 
Edit -> Copy All - Copy the whole RDF document that is 
currently open and put it in clipboard. 
Edit -> Undo - 1-level down implementation of undo. If 
someone accidentally add or remove any component from 
the file, you can use undo to undo the previous action. 
Pressing undo twice will bring back the change done. 

Tools Menu 
Tools -> Generate N-Triple report - Generate N-Triple 
report from the currently open RDF file and show it in the 
Report area (bottom half). 

B. Twinkle: Sparql Tools 
Twinkle is a simple GUI interface that wraps the ARQ 

SPARQL query engine. The tool should be useful both for 
people wanting to learn the SPARQL query language, as 
well as those doing Semantic Web development. 

Features: 
Load, edit and save SPARQL queries. 
Insert PREFIX statements into queries. 
Configure custom namespaces so they can be quickly 
inserted into queries. 
Cancel long running queries. 
Save results to file. 

Query local files and remote RDF documents. Query 
RDF data held in relational databases. Query online 
SPARQL endpoints, such as DBpedia, reyvu.com and 
GovTrack.Query using standard SPARQL, or the ARQ 
extended syntax which supports COUNT, etc. Use ARQ 
extension functions and property functions. Apply 
inferencing (e.g. Jena rules, RDF Schema, OWL ontology) 
when running queries.Configure commonly used data 
sources for quick access. 

V. RESULTS AND DISCUSSION 

A. RDF document creation 
RDF Editor is used to make the RDF document for cars 

image repository. Self defined tags are used to annotate the 
images. Figure.7 shows RDF document created using RDF 
Editor. 

 

 
Figure .7 Creating RDF document using RDF Editor 

 
The RDF document has been validated through online 

W3C RDF validation Service. This validation process 
generates the triples (subject, predicate, and object) for the 
RDF document (Data Model). The validation process is 
shown in figure.8 

 

 
 

Figure.8 Validation of RDF using W3C RDF Validation Service 
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Figure.9 shows the graph predicate and object (triples) 
generated for our data model showing the subject, predicate 
and object of few entities of RDF document. 

V. QUERY RESULTS 

SPARQL tool is used to query the RDF document from 
different perspectives. The SPARQL, a RDF Query 
Language, has been used to write queries. 

A. Query 1 
Query 1 (as shown in figure 5.4) retrieves all the 

information for concept cars from the RDF document 
generated in figure 10 Results are generated in the form of 
triples 
(path, attribute, value). 

 
 

Figure.10 Query and output for all type of cars 

B. Query 2 
Figure 11 shows output for query on “cars with model 

name ‘Honda’, color ‘red’ and kerbweight = 1250 kg. 
 
 

 
 

Figure .11 Query and output for cars of ‘Honda’ brand, color is ‘red’ and 
Kerbweight=1250 kg. 

VI. CONCLUSION  

This survey work concludes that the RDF is a very 
powerful tool to annotate images and create data models for 
the repositories of the different types of resources. The 
predefined tags used in RDF capture all the targeted 
information about the resources (images in our case) and put 
ahead a way to make all the searches over the defined 
repository more relevant and accurate. The SPARQL, a 
query language as well as a data access protocol, armed with 
all features that any general purpose query language can 
possess solves the purpose of making RDF a true machine 
understandable language. It has been confirmed that the 
query results exactly match with what the user desires. 

Both, the RDF and the SPARQL combined together can 
serve as a platform to fulfill the vision of Semantic Web, as 
proposed by Tin Berners Lee. As the amount of images are 
growing exponentially on the WWW, using self defined tags 
and annotations will always increase the efficiency and 
precsion of image retrieval. 

There is scope for extending this work is on the 
following aspects: 

The RDF document of car repository can be modified 
by adding new tags to it which can bring additional 
information to data model of cars and therefore enhancing 
the users’ capability to search more meaningful contents or 
making a way to enhanced semantic search over the 
Internet. More profound SPARQL queries can be written in 
order to provide other related contents (those contents which 
are semantically linked to the exact content) to the users in 
response to their search on the Internet. 

VII. REFERENCES 
[1] Berners-Lee, T., Hendler, J., and Lassila, O., 2001, 

“The Semantic Web”, Scientific American, 284: 34–43. 
[2] W3C Semantic Web Activity, 1994–2006, 

http://www.w3.org/2001/sw/. 
[3] Gerber A.J., Van der Merwe A.J. and Barnard A., 

“Towards a Semantic Web Layered Architecture”, In 
Proceedings of the International Conference on 
Software Engineering (IASTED SE2007), February 13-
15, 2007, Innsbruck, Austria, ISBN: 978-0-88986-641-
6. 

[4] Liyang Yu, “Introduction to the Semantic Web and 
Semantic Web services”, Chapman & Hall/CRC, Taylor 
& Francis Group publication. 



T. Sumathi et al, International Journal of Advanced Research in Computer Science, 2 (4), July-August, 2011,27-33 

© 2010, IJARCS All Rights Reserved          33 

[5] I Horrocks and J. Hendler, “The Semantic Web”, in 
proceedings of First International Semantic Web 
Conference, Sardinia, Italy, June 9-12, 2002. 

[6] S. Decker, S. Melnik, F. van Harmelen, D. Fensel, M. 
Klein, J. Broekstra, M.Erdmann and I. Horrocks, “The 
Semantic Web: The Roles of XML and RDF”, IEEE 
Internet Computing, Vol. 4(5), pp. 63-74, Sept/Oct 
2000. 

[7] Resource Description Framework (RDF), 
http://www.w3.org/RDF/ 

[8] Manola et al., “RDF Primer”, F. Manola, E. Miller 
(eds.): W3C Proposed Recommendation December, 
2003, http://www.w3.org/TR/2003/PRrdfprimer-
20031215. 

[9] Atanas Kiryakov, Borislav Popov, Ivan Terziev, 
Dimitar Manov, Damyan Ognyanoff, “Semantic 
annotation, indexing, and retrieval" J. Web Sem. 
2(1):49-79 (2004). 

[10] Semantic Annotation, 
http://www.ontotext.com/kim/semanticannotation.html 

[11] K.S. Candan, H. Liu, and R. Suvarna, "Resource 
Description Framework: Metadata and Its 
Applications", ACM SIGKDD Explorations, July 
2001.3(1):6-19. 

[12]Douglas Heflin, J., “Towards the Semantic Web: 
Knowledge Representation in a Dynamic, Distributed 
Environment”, PhD Thesis, 2001. 

[13] L.Hollink, A.Th.Schreiber, J.Wielemaker, B.Wielinga. 
“Semantic Annotation of Image Collections”, in 
proceedings of the KCAP'03 Workshop On Knowledge 
Capture and Semantic Annotation, Florida, October 
2003. 

[14] Oge Marques and Nitish Barman, "Semi-automatic 
semantic annotation of images using machine learning 
techniques", International Semantic Web Conference 
(ISWC) 2003, October 20-23, 2003, Sanibel Island, FL. 

[15] Osman, T., Thakker, D., Schaefer, G., Leroy, M., and 
Fournier, A.,"Semantic Annotation And Retrieval Of 
Image Collections", In the proceedings of the 21st 
European Conference on Modelling and Simulation, 
June 4-6, 2007, Prague, Czech Republic, pp. 324-329. 

[16] Elahi, N., Karlsen, R., Akselsen, S. “A Context Centric 
Approach forSemantic Image Annotation and 
Retrieval” Future Computing, Service 
Computation,Cognitive,Adaptive,content Patterns, 
2009. COMPUTATION WORLD '09. Computation 
World 15-20 Nov. 2009, pp. 665 – 668. 

 
 
 
 
 
 


